
Chapter 4:  SEER*DMS Workflow 
The SEER*DMS workflow is a configurable mechanism to move records through automatic and 
manual tasks.  The workflow controls the path of a record through editing, screening, matching, 
and consolidation tasks with the ultimate goal of incorporating it into patient set data.   

Each record is initially processed in an automated task.  If human attention is required to complete 
a task, a manual task is initiated.  Once a user completes the manual task, the record continues to 
the next automatic task in the workflow.  The record moves from automatic to manual processes 
as necessary, until it completes its journey through the workflow.   

The SEER*DMS worklist provides a view of the automatic tasks that are currently running and the 
manual tasks that require attention.  Manual tasks are created to process patient data, view report 
output, and to review import statistics.  The manual tasks displayed in the worklist are the staff’s 
“to do list”.  The automatic tasks are displayed in the worklist to allow you to track the flow of data 
and, in rare situations, to cancel automatic processes. 

A unique Task ID is assigned to the first task created when a record enters the workflow.  As the 
record moves from task to task, the Task ID remains the same.  The same Task ID is retained until 
the record exits the workflow.    

In this chapter, you'll learn about 

• Accessing the Worklist 
• Worklist Data Columns and Filters 
• Sorting the Worklist 
• Worklist Task IDs 
• Assigning or Releasing Tasks 
• Auto-assigning Worklist Tasks to User Accounts 
• Worklist Flags 
• Auto-setting Worklist Flags 
• Report and Extract Worklist Tasks 
• Terminating Manual Tasks 
• Refresh or Restart Workflow Activity 
• Aborting Automatic Tasks 
• System Failure Tasks 
• Worklist Tasks 
• Workflow Listings and Reports 
• Workflows by Record Type (with Diagrams) 
• Technical Implementation of the Workflow 

Accessing the Worklist 
There are many ways to access the worklist.  The most common method is to click one of the 
shortcuts shown on the home page.  You can also select View -> Worklist.  The method that you 
use to access the worklist only determines the initial filter settings.  Once you are in the worklist, 
you will be able to adjust the filters to view an appropriate list of tasks.  The system permissions 
assigned to your user account determine which tasks you will be able to view and access.  

There are numerous shortcuts to the worklist on the home page.  Your registry’s policies will 
determine which links you should use.  In most registries, users are instructed to focus on tasks 
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assigned to their account (displayed in the Mine tab on the left).  You may also be instructed to use 
worklist flags to identify high priority tasks or to work on a certain task type.   

 

All links in the Tasks sections on the left and right sides of the home page will take you to the 
worklist.  The Tasks link that appears above the tabs can be used to view all tasks for that tab. For 
example, click Tasks while viewing the Mine tab to view all tasks assigned to your account 
regardless of task type. 

When you open a worklist task, it is assigned to your account to prevent two users from 
inadvertently working on the same task.  Once assigned, tasks may be rerouted to other users or 
designated as unassigned.  The steps and account permissions required to assign or release tasks 
are described in Assigning and Releasing Tasks. 

Worklist Data Columns and Filters 
The following data columns are shown in the worklist: 

• Flags – Tags to indicate that there is something “special” about the task.  Flags are 
assigned to tasks to mark priority tasks, problem tasks, and tasks related to certain 
projects.  A flag can be assigned to a task manually; or automated rules can be defined in 
the Task Manager (System > Workflow > Task Manager).  

• Task – Unique ID assigned to the series of processes used to move the data through the 
workflow.  The same ID is maintained as a record moves from one type of task to another.  
TSK is the prefix for task IDs. 

• Task Type – The types of tasks are described in the Worklist Tasks section of this chapter. 
• User - The user account to which the task is assigned. 
• Age – Length of time since the task was created (shown if the Action > Toggle Age/Date is 

set to show age).  Age is reset when the data move forward to a new task type. 
• Task Date – Date and time that the task was created.  Date is reset when the data move 

forward to a new task type.  This is only shown if Toggle Age/Date is set to show the date. 
• ID – For most tasks, this is the ID of the Patient Set or Record that is the focus of the task. 

If the processing of a record triggered the task and the record is not yet linked to a patient 
set, the Record ID will be shown.  Once the record is linked to a Patient Set, the Patient Set 
ID will be shown.  The ID shown for a Report Output task is the system report ID (RPT 
prefix).  The Import ID (IMP prefix) is shown for an Import Review task. Click the 
Information Icon  next to the ID to see values of key fields.   

2 5/21/2015  SEER*DMS User Manual 



• Type – The Type column shows Data Type.  It is blank if the task is not related to a record.  
A two-character abbreviation is used:  NA = NAACCR Abstract, NM = NAACCR Modified, DC 
= Death Certificate, etc.  Record types and abbreviations are listed in the Data Type filter; 
or hover your mouse over the abbreviation to view the full text. 

• Reg – Region.  This column is only displayed if your registry’s implementation of SEER*DMS 
is configured to support multiple regions.  Region is assigned to a record or patient set by 
registry-specific polishers.  It is typically based on the region of the facility that sent the 
data.  Region is not applicable to worklist tasks that do not relate to patient data, for 
example, there is no region assigned to Report Output or Import Review tasks. 

• Event Date – This is typically date of diagnosis.  If a record is the focus of the task then 
the record’s Event Date is used.  The Event Date is calculated by a polisher and is the date 
of diagnosis, if available.  Otherwise, it is set to the value of another date field on the record 
such as screening date, date of admission, or date of last contact (please refer to the 
documentation for the Date of Event Polisher on the Polishers help page).   
For Patient Set tasks, the date of diagnosis for a CTC is used.  If the Patient Set has 
multiple CTCs and all CTCs are error-free, this will be the date of diagnosis of the CTC to 
which the task’s original record is linked.  Otherwise this column will contain the date of 
diagnosis for the earliest diagnosed CTC that has edit errors.  This field is populated in this 
manner to enable you to identify tasks that must be completed for the next submission. 

• Facility – Reporting facility. 
• Site – Cancer site.  The site coded on the incoming record is used if the record has not yet 

been linked to a patient set.  Once the record is linked to a patient set, the site and year of 
diagnosis are based on a CTC in the patient set.  Refer to the description of Event Date for a 
description of the CTC that is selected. 

• Information – A text field displaying additional task-specific data items (Patient Name, 
match results, IDs of failing edits for edit-related tasks, etc.).    

You may filter the worklist by any fields shown in the data columns.  The fields listed below are 
available as filters, but not shown in worklist data columns.  

• Task Date - Age and Date are two expressions of the same attribute, the time that the 
task was created.  The worklist allows you to filter on this attribute using date filters.   

• Status - Use this filter to find a task based on its execution status.  All manual tasks have a 
status of Waiting.  Automated tasks will either have a status of running or failed. 

• Last Name – This filter provides a method to search for a task by the patient’s last name 
or for patients’ whose name starts with specific letters.   In some registries, sets of letters 
are assigned to coders.  For example, a coder in one registry completes tasks for patients 
whose names start with any of these letters:  “H L F Y”.  The letters must be separated with 
a space to use the filter to find patients whose name starts with any of those letters. 

• Reportability - Use the Reportability filter to search for record tasks by the record’s 
reportability flag.  Once the record is linked to a patient set, the patient set becomes the 
focus of the task.  The Reportability filter cannot be used to search for Patient Set tasks. 

• Import – Use this filter to search for record tasks based on the Import ID. 
• Open AFL – This filter was designed to facilitate searches for records that triggered an AFL, 

the AFL is still open, and the record is in an incomplete worklist task.  It can also be used to 
find patient sets that are in the worklist and have an open AFL. 

• AFL Closing Record – Use this filter to find records that closed an AFL.  Typically, this 
would be an abstract that matched an AFL for a pathology report, death certificate, or case 
finding record.   Other types of records, such as Short Health Records, may also close AFLs. 

• Special Study – Use this filter to find tasks for records or patient sets in Special Studies. 
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• Data Search Filter – This filter allows you to create custom filters based on any criteria 
related to a record, patient set, task, or facility.  To do this, create a Data Search that 
returns the display ID for a Patient Set, Record, Facility, or Task.  Save that Data Search as 
a filter for the Worklist Manager. 

The fields listed below are available as worklist filters in some, but not all, registry configurations.  

• Class Of Case – The value in this filter is matched against the class of case in records 
associated with tasks; or the class of case in admissions for patient set tasks.  

• Vendor – This filter can only be used to search for record tasks.  The value entered in this 
filter is matched against the Vendor Name field in the records.   

• Abstracted By – In some registries, the abstractor’s Contact ID with a PER prefix is listed 
in the worklist information field.  If a Contact ID is not available, the 3-character abstractor 
ID is listed.  To facilitate faster searching, the Abstracted By filter executes a match against 
the text in the information field rather than matching against record values. 

Instructions for setting filters are provided in the Filter Tutorial available with the SEER*DMS user’s 
manual: seer.cancer.gov\seerdms\manual.  

Sorting the Worklist 
In SEER*DMS, the data displayed in a table are sorted by the data item with a highlighted column 
header (highlighted in red in the example below). In the example below, the worklist is sorted by 
Task ID.  The up arrow next to “Task” indicates that the table is sorted in ascending order.   
 

 
 
You may sort by a column if the column header is underlined.  You cannot sort the worklist by the 
data in the ID column; but you can sort by all other data items.  To sort the worklist, click on a 
column heading.  To reverse the sort order, click that column header again.  If you create a saved 
filter, the sort order will be stored as an attribute of the filter.  For more information on filters, 
please refer to Chapter 3:  Using SEER*DMS. 

Worklist Task IDs 
A Task ID is assigned when an incoming record triggers the initial task in the workflow.  As the 
record moves from task to task, the same Task ID is maintained.  The Task ID is shown in the TSK 
menu when you are working on a task.  In the example below, a Match-Consolidate task is open 
and the task ID is TSK-6341779. 

 
 
When you finish a task, a message is displayed at the top of the Worklist, informing you that data 
were updated.  The message includes the Task ID and either the Patient Set or Record ID, as 
shown below. 
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The same Task ID is retained until the processing for the record is complete and the record exits 
the workflow.  At that point, there will be no tasks in the workflow with that Task ID.  However, 
tracking information is retained in the workflow history table of the database.  That history can be 
viewed by opening the record in the editor and selecting Workflow History from the record menu. 

Assigning or Releasing Tasks 
System permissions:  worklist_task_reassign_all, worklist_task_reassign_mine 

Tasks can only be assigned to a user who has the system permission to complete the task.  A user 
can open tasks assigned to their account; and tasks that are unassigned.  When a user opens an 
unassigned task, the task is assigned to that user’s account. 

To assign or release an open worklist task: 

1. If you wish to set a worklist flag before you release the task or assign it to another user: 

a. Select Worklist Flags from the TSK task menu (the task menu is displayed as the Task 
ID and is on the menu bar next to View). 

b. Check the flags that are appropriate for this task. 

2. To assign the task to another user, select Reassign from the TSK menu. 

a. Set the Action to Assign to User Account, and select a user name from the list. The list 
will only include users who have the system permissions required to open the task. 

b. Enter text into the Comment box.  This text will be included in the e-mail notification 
sent to the user receiving the task. 

3. To designate the task as unassigned, select Task > Release from the TSK menu. 

4. If you have the system_administration permission, Terminate and Restart will be included 
on the TSK menu (Restart will only be available in tasks related to records, not patient 
sets).  These actions should be used with care (see the Terminating Manual Tasks and 
Restarting Workflow Activity sections of this chapter for more information).  

To use the Worklist to assign or release worklist tasks: 

1. Select View > Worklist or use a shortcut on the Home Page to go to the worklist. 

2. Set the appropriate worklist filters.  Instructions for using the filters are provided in the 
Filter Tutorial on the SEER*DMS training website:  seer.cancer.gov\seerdms\manual.  

3. The check boxes in the first column allow you to select individual items in the list. If items 
are checked, actions are applied to the checked items.  If no items are checked, actions are 
applied to all items in the filtered list.  Select the tasks to modify: 

a. To select specific tasks on the current page, check the boxes to the left of the Task ID.  
Check boxes can only be checked on a single page, the checks will clear if you go to 
another page in the worklist. 

b. Or use the filters to limit the worklist to the tasks that you wish to modify. 

4. Select Actions > Modify. 

5. To assign the selected tasks to one or more users: 
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a. Set the Action to Assign to User Account(s) 

b. If you would like to select users based on a system role, select that role in the drop-
down list.   

c. Check one or more user names in the list.  The list will only include users who have the 
system permissions required to open all of the selected tasks.  If multiple users are 
selected, the tasks will be divided among those users 

6. To change the task(s) to unassigned, set the Action to Release to Unassigned List. 

7. Enter text into the Comment box.  This text will be included in the e-mail notification 
related to this action.  SEER*DMS sends an e-mail notification to a user each time a task or 
set of tasks are assigned to their account 

8. Click OK.  A warning will be displayed if more than 100 tasks are modified. 

Auto-Assigning Worklist Tasks 
Worklist tasks can be auto-assigned to users.   Registry criteria are defined in Groovy scripts which 
can be viewed and modified via the SEER*DMS Task Manager (go to System > Worklist > Task 
Manager). The Assignment tab of the Task Manager contains scripts to auto-assign tasks to system 
users.  The IMS Technical Support team will provide assistance in creating and maintaining the 
scripts.  A sample script is shown whenever you add a script. 

• The Help section of the editor shows a list of Functions that can be used and allows you to 
search for data items (Properties).   

• A script should not re-assign a task that is already assigned to a user.  If task.getUser() is 
not null then the script should return Result.currentUser() and the task will not be changed.   

• Many registries include rules to auto-assign tasks based on patient’s last name.  This 
prevents two users from editing the same data. 

• The sample script below assigns Match-Consolidate tasks to the abstractor, if the abstractor 
is a SEER*DMS user.  Otherwise, the task is assigned based on patient’s last name.  The 
help panel shows information for the getRecordProperties() function. 
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Worklist Flags 
A worklist flag is a tag associated with a task to indicate that there is something “special” about the 
task.  Flags provide a way to search for priority or problem tasks.  For example, a worklist flag can 
be set to indicate that a task is related to a record that is likely to generate a new reportable case.  
Registry management can create worklist flags; registry staff can set flags for a task. The flags 
listed below are distributed with SEER*DMS.  

Flag Description Explanation 

 Probable New  
Patient Set 

The automatic match task did not find a matching patient set.  The 
match criteria are defined in the Match-Consolidate flag script. It is 
likely that this record will become a new patient set.  

 Probable New CTC The automatic match task did not find a matching CTC.  The record 
will likely become a new CTC in an existing patient set. 
 
The match criteria are defined in the script to set flags for Match-
Consolidate tasks. 

 Problem Case  This flag is typically assigned to a task by a user.  However, the 
registry may define a script to auto-assign the flag. 
 

 CFO The task is for a record being built into a Casefinding Only case. 

 
 
 

DCO The task is for a record being built into a Death Certificate Only case. 
SHO The task is for a record being built into a Short Health Only case. 
MDO The task is for a record being built into a DCO case using the defaults 

for data received from physician offices (MDO). 

To define or modify worklist flags (requires manage_worklist_flags permission): 

1. Select System > Workflow > Worklist Flags. 

2. To create a new flag, select Actions > Add.  To modify the icon or name of a flag, click 
Edit for that flag. 

3. In the Flag field: 

a. Specify one or two characters for the flag’s icon. 

b. Click Color and select the background color for the flag’s icon. 

4. Enter the flag’s Name.   The Name is shown when a user hovers over the icon and in the 
list of flags displayed when a user sets flags for a task. 

5. Enter a Description to document the purpose of the flag.  Click Save. 

A priority is assigned to each flag.  It is a sequence from 1 to the number of flags.  The priority 
determines the order in which flagged tasks are listed on the user’s home page.  Tasks with priority 
= 1 are listed first.  To change the priority of a flag:  select Actions > Set Priority.   You may drag 
the flags up and down within the list to change the priority. 

Auto-Setting Worklist Flags 
The registry may define scripts to automatically set flags on worklist tasks.  Scripts are distributed 
in the initial deployment of SEER*DMS to set the P and C flags.  The CF, DC, SH, and MD flags are 
set by source code in the application rather than the Task Manager scripts. 
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Registry criteria to set flags can be defined in the scripts.  The scripts can be accessed via the 
SEER*DMS Task Manager (go to System > Worklist > Task Manager).   The Assignment tab of the 
Task Manager contains scripts to auto-assign tasks to system users; the Flags tab contains scripts 
to automatically set flags on tasks. 

The IMS Technical Support team will provide assistance in creating and maintaining the Assignment 
and Flag scripts.  A sample script is shown whenever you add a script. 

Report and Extract Worklist Tasks 
An automatic task is started when a user runs a system report or extract.  When the automatic 
task finishes successfully, a manual Report Output task is created and assigned to the user who 
submitted the report or extract.   Instructions and options for running reports and extracts are 
provided in Chapter 24:  Creating Reports and Extracting Data.   

Report Output tasks have characteristics that differ from tasks related to records moving through 
the workflow.  These are described below. 

• The report or extract ID is listed in the ID column of the worklist (RPT or EXT prefix). 
• Report Output tasks can be removed by the user to whom it is assigned.  The Remove 

Report Output action allows you to remove a single task or a set of tasks.   
• Report Output tasks expire after a period of time.  The length of time is set in configuration 

parameters (report.removal.time and extract.removal.time).  The default is 90 days for 
extracts and 30 days for reports. Email notification is sent when reports expire.  To keep a 
permanent copy of a report or extract, you must download it to your computer or network. 

• You can assign a Report Output task to any user, but they will only be able to open it if they 
have the permission associated with the report.  For example, a report designated for 
managers only can be opened by a user with the reports_management permission.   

To remove Report Output tasks assigned to your account: 

1. To remove a single report or extract, open the task and click Remove. 

2. To remove a set of reports or extracts, select the Report Output tasks in the worklist using 
one of these methods: 

a. Use the filters to create a list containing the reports to be removed. 

b. Or check the box next to each Task ID. 

3. Click Modify. 

4. Set the Action to Remove Report Output. 

5. Click OK.   

Terminating Manual Tasks 
System permissions:  worklist_task_terminate_manual 

You may use the terminate feature to end manual worklist tasks.  The terminate feature should be 
used with extreme care when modifying tasks that relate to the processing of patient data.  The 
task is ended without forwarding the record or patient set to subsequent processes in the workflow.   

You may terminate a single task by opening the task and selecting Terminate from the Task’s 
menu.  You may also terminate one or more tasks using the Modify action in the worklist. 
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To terminate tasks in the worklist: 

1. Use the filters to create a list containing the tasks to be terminated.  For example, you may 
be terminating all tasks for records loaded in a particular import. 

2. Carefully verify that your filter settings are correct before proceeding.  Review the worklist 
to see if the appropriate tasks are listed. 

3. Click Modify. 

4. Set the Action to Terminate. 

5. Click OK and confirm the action when prompted.  The tasks will be removed from the 
workflow.  SEER*DMS will send an e-mail notification to you and the system administrator.  
An entry will be added to the record’s Worklist History indicating that the task was 
terminated. 

Instructions for ending automated tasks are provided in the Viewing or Aborting Automatic Tasks 
section of this chapter.  

Refresh or Restart Workflow Activity 
System permission:  worklist_task_refresh or worklist_task_restart  

At times, registry staff may need to refresh a stale task.  Refreshing a task simply re-runs the 
automatic portion of the task.  For example, the edits are re-executed when a Resolve Patient Set 
Errors task is refreshed.  Record and patient set tasks can both be refreshed.   

If a patient set is updated by any process, the edits are re-evaluated.  If the patient set is in a 
Resolve Patient Set Errors task and all edits are resolved, the task will auto-close.  If changes are 
made to the computerized edits, you can re-execute the edits on all patient sets using the Patient 
Set Edits system tasks.  Resolve Patient Set Errors tasks will auto-close if all edits are resolved.  
Therefore, you will rarely need to refresh Resolve Patient Set Errors tasks.  This would only be used 
if you wanted to test a change to an edit on tasks before executing the system task to refresh edits 
on all patient sets. 

In addition, records in tasks can be sent to an earlier point in the workflow.  Sending a record to an 
earlier point in the workflow is more dangerous and should be done with care.  Contact IMS 
technical support if you need to restart tasks and are not sure of the possible side effects.   

To refresh tasks: 

1. To refresh a set of tasks, use the filters to create a list of tasks. 

2. Select Actions > Modify. 

3. Set Action to Refresh Tasks. 

4. Click OK and then confirm the action when prompted. 

To send records to an earlier point in the workflow: (proceed with care) 

1. To restart an open task, select Restart from the TSK menu. 

2. To restart a set of tasks, use the filters to create a list of the tasks to be restarted. 

3. Select Actions > Modify. 

4. Set Action to Start Tasks at Earlier Point in Workflow. 

5. Review the number and type of tasks.  Verify that you wish to proceed. 
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6. Select the point in which the task will re-enter the workflow.  The tasks are listed in the 
order in which they occur in the workflow.  You cannot push tasks forward in the workflow, 
that is, you cannot restart a Screening task at the point of Matching. 

a. Auto-coding – the rec-coding polishers will be executed.  Review the rec-coding 
polishers for the appropriate record type(s) to determine if this is an appropriate 
action.  The logic for each polisher is documented on the Polishers help page. 

b. Record edits – all record edits will be executed.  The results will determine whether a 
manual Resolve Record Errors task is created as described in Chapter 8:  Resolving 
Record Errors.  As an example, you may wish to restart tasks at this point after 
correcting a poorly defined edit that created a large number of Resolve Record Errors 
tasks.  If a manual edits task is not created, the record will continue moving through 
the workflow. 

c. Screening – the algorithm to set the reportability flag will be re-applied.  These 
algorithms are documented on the Screening help page.  You may wish to restart 
tasks at this point if the screening algorithm was modified and you wish to apply the 
new algorithm to records loaded prior to the change. 

d. Matching – the automatic matching task will be refreshed.  This will reset the worklist 
flags and information text that are set by the automatic match task.  If you are 
restarting pathology reports that use the Pull List workflow then the records will be 
sent to the automatic Path Matching task. 

7. If you want to release the tasks, check Set as Unassigned.  Do not check this box to 
retain the current assignment. 

8. AFLs are created for some records as they move through the workflow.  The records that 
you are sending back into the workflow may have AFLs.   You have the option of deleting 
the AFLs and creating new AFLs per current algorithms.  Do not check this option if you do 
not want changes to the AFLs.  

9. Click OK and then confirm the action when prompted. 

Aborting Automatic Tasks 
System permission:  worklist_task_terminate_auto 

When SEER*DMS performs an automated process, an automatic task will appear in the worklist. 
These items allow users to track the progress of automatic tasks through the workflow, and view 
additional information about an item, if necessary.  

SEER*DMS will run most automated processes quickly, and remove the item from the worklist as 
soon as the task is completed. On rare occasions, a system administrator may need to abort an 
automated process.  If you have the worklist_task_terminate_auto permission and determine that 
an automated task needs to be canceled, open the task and click Abort Task.  

System Failure Tasks 
A System Failure task will be created if SEER*DMS is unable to perform a process.  The task type 
will be displayed in red and ‘FAILURE’ will be printed in the information text.  A user who has the 
permission to perform the initial task will be able to open the System Failure task. When you open 
the task you will see the type of workflow activity that failed, the time and date that the activity 
was started, and the runtime exception generated.   

If you cannot evaluate the information, contact your registry IT staff or submit a SEER*DMS 
technical support issue.  Technical support team will determine if a Retry would be appropriate.   
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Worklist Tasks 
The manual workflow tasks are listed below.   

 
Manual Tasks Function 
Consolidate Combine data from incoming records with data previously loaded 

into the system (Chapter 12:  Consolidating Data). 
Consolidate FUP Resolve conflicts encountered during the automated 

consolidation of follow-up information (Chapter 16: Follow-up). 
Image Data Entry Enter record data stored in an image file. 
Import Review Review a pre-load analysis of an import in order to identify 

potential errors prior to loading the records into the workflow 
(Chapter 5:  Importing Data Files). 

Match-Consolidate Review possible matches for an incoming record (main workflow 
path).  Determine whether the record should be consolidated 
with an existing Patient Set, or if it refers to a new Patient Set 
(Chapter 10:  Matching Incoming Records to Database). 

Pathology Screening Code site, histology, behavior, grade, and the reportability flag 
on records containing pathology reports.  This task is typically 
used to screen HL7 records; it may also be used to screen 
casefinding records in some registries. 

QC Patient Set 
QC Record 

Manual Quality Control tasks that can be created by registry 
staff.  QC Tasks can be created in the Data Search.  Use the 
search to select the records or patient sets and then select 
Create QC Task from the Action menu.  

Report Output Access the output of a report that ran offline (Chapter 24:  
Creating Reports and Extracting Data). 

Resolve Duplicate Patient 
Set 

This task identifies a Patient Set that was recently modified and 
may be a duplicate of another Patient Set.  An automatic task is 
executed each night to identify possible duplicates. 

Resolve Patient Set Errors Resolve errors identified in the final automated review of the 
patient set (Chapter 14:  Resolving Patient Set Errors). 

Resolve Record Errors Resolve errors which must be resolved prior to screening 
(Chapter 8:  Resolving Record Errors). 

Review Data The Review Data is a patient set task that can be created during 
ad hoc editing sessions. To create the task, you select Create 
Review Task from the Patient Set menu and enter instructions.  

Review Path Matching Review possible matches generated by the automatic path 
matching task.  A pathology report is matched against patient 
sets and reject records as part of the Pull List workflow. 

Review Pull List Determine if a pathology report should be included in the “Pull 
List”.   If the record is included then an AFL is created and the 
medical records will be “pulled” for a chart review.  

Review Special Studies A task created when a manual review is required to determine 
special study eligibility.  (Chapter 28:  Special Studies) 

Screening Screen an incoming record for reportability (Chapter 9:  
Screening for Reportability). 

Supplemental Match Review matches to a record in the supplemental workflow.  This 
task is created if the record matches two patient sets; possible 
matches are rarely defined in supplemental match algorithms. 
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Workflow Listings and Reports 
To create a printout or listing of tasks in the worklist, select Export from the Actions menu.  This 
creates an export file in Comma Separated Values (CSV) format.  Open the file in Excel to format 
and print the list.  These SEER*DMS system reports can be used to monitor data and tasks in the 
workflow.  
 
Report ID Title Description 
RPT-003A Tasks for Unlinked Records 

with Closed AFLs 
Lists workflow tasks for unlinked records which are 
associated with closed AFLs. 

RPT-008B FUP Abstract Workflow 
Summary 

A summary of results for records processed by FUP 
Abstract workflow algorithms. 

RPT-008C DC Duplicate Workflow 
Summary 

A summary of results for records processed by DC 
Duplicate workflow algorithms. 

RPT-061A Workflow Location of 
Imported Records 

This report lists the current location of the record 
in the workflow.  It is paged by the import data file 
which contained the original record. 

RPT-062A Workflow Tasks by Facility 
and Year of Diagnosis 

Workflow tasks by source facility and diagnosis 
year. 

RPT-075A Number of Open Worklist 
Tasks by Data Type 

Number of open, manual workflow tasks by year of 
diagnosis and data type.  

RPT-075B Number of Open Worklist 
Tasks by User 

Number of open, manual workflow tasks by user 
account (total, number of unassigned tasks, and 
number assigned to each user).  

RPT-082A Number of Workflow Tasks 
Completed (by Task) 

The number of workflow tasks completed in a 
specified time period.  This report includes a list of 
users for each type of task. 

RPT-082B Number of Workflow Tasks 
Completed (by User) 

The number of workflow tasks completed by each 
user in a specified time period.  This report lists 
the number of tasks per user. 

RPT-096A Priority Worklist Tasks 
(Probable New Patients) 

This report lists records in the workflow that likely 
represent new patients. 

RPT-096B Priority Worklist Tasks 
(Probable New Cases) 

This report lists probable new cases for existing 
patient sets. 

RPT-100A Abstracts in Workflow that 
Match Patient Set with an 
Open AFL 

A list of abstracts that are in the workflow, match 
a patient set based on SSN, and that patient set 
has an open AFL.  This report only considers AFLs 
that have a Patient Set as the source. 
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Workflows by Record Type 
Workflow diagrams by record type are available in Figures 1 thru 4 at the end of this chapter.  
These are generic diagrams, that is, they indicate points which use registry-specific logic but the 
registry algorithms are not documented in the diagrams.  To truly understand the workflow for a 
specific record, you will need to review the appropriate diagram and your registry’s algorithms.  
Registry algorithms are documented in the SEER*DMS help system.   The text below describes the 
processes and decision points shown on the diagrams.  The Workflows column indicates if the 
process is used in the workflow of all record types; or if it is limited to specific record types. 
 

Process Description Workflows 
Create Record via Import 
Algorithms or Data Entry 

The import processes include identifying 
and ignoring duplicate records; loading 
data into record fields; and applying 
import conversion rules.  The import 
algorithms are described in Chapter 5 
and registry-specific documentation is 
available on the Imports help page in 
SEER*DMS. 

The workflows of all record 
types use this process. 
 
Note:  a temporary record is 
created for supplemental 
record types; the record is 
only stored in the database if 
a manual task is required. 

Auto-coding Automatic task that executes polishers 
in the rec-coding-type and rec-coding 
classes.  To view documentation for 
polishers, select Help > Polishers. The 
class is shown on the right side of the 
screen for each polisher. 

Workflows of all record types. 

Record Edits Validate the record using edits.  The 
registry has the ability to validate the 
record at two points in the workflow.   

• Edits may be executed just 
before the record is screened; 
edits are often used at this point 
to identify records that are 
missing critical data items.   

• Edits may also be executed just 
after the screening task; this 
allows the registry to restrict 
validation to records that are 
known to be reportable.   

A manual edits task is created if a 
record edit fails and the edit’s severity is 
critical or high. 
 
Use the Edits Manager to view edits, 
edit conditions, and relevant 
documentation.  

Workflows of all record types. 
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Process Description Workflows 
Screen for Reportability Apply screening algorithms and set the 

reportability flag on the record.  The 
algorithms are documented on the 
Screening help page. 
 
 

Used in workflows of record 
types that contain cancer 
data (abstracts, path reports, 
death certificates, casefinding 
records).  This includes 
follow-up only records in 
some registries; excludes 
supplemental records in all 
registries.  The value of the 
reportability flag is “not 
applicable” if the record’s 
type is not screened. 

Match to AFLs The record is matched against open 
AFLs using the criteria documented in 
the Matching: AFL to Record section of 
the matching help page. 
 
The AFL is closed if the record and AFL 
match and the record can close AFLs 
according to the registry’s rules.  The 
auto-close rules are documented in the 
Match Closing Record to AFL section of 
the AFL help page. 

Used in workflows of records 
that have the ability to close 
AFLs.  These are NAACCR 
Abstract, NAACCR Modified, 
and Health Records in most 
registries.  This includes 
Short Health records in some 
registries. 

Rapid FUP An automatic task that updates follow-
up fields based in a matching patient 
set.  The primary goal of the task is to 
update vital status in the patient set 
without waiting for manual consolidation 
tasks to be completed.  The matching 
algorithm used for Rapid FUP is 
documented in Linkage: Rapid Follow-
up section of the matching help page. 

Not used in the supplemental 
workflow or for update 
records.  Used for all other 
record types. 

Match to Abstracts 
Match to Death 
Certificates 

Compare an abstract record to other 
abstract records; or compare a death 
certificate record to other death 
certificate records. 
 
If the incoming record is an updated 
version of a record in the database; 
auto-consolidate the two records.  One 
record is updated and retained; the 
other record is deleted.  If the original 
record was linked then the patient set is 
automatically updated. 
 
Registry matching algorithms are used 
to identify potential duplicates.   

Abstracts in the NAACCR 
format are matched against 
other abstracts; death 
certificates are matched 
against death certificates.  
Record types considered for 
the abstract comparisons are 
NAACCR A, NAACCR M, 
NAACCR CF. 
 
In a future version, this task 
will support all record types. 
At this time, only abstracts 
and death certificates are 
consolidated at the record 
level. 
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Process Description Workflows 
Linkage Match Match the record against data in the 

database.  The matching algorithm 
determines if it is matched against all 
patient sets and unlinked records. 
Linkage matching algorithms are 
documented on the Matching help page. 

Workflows of all record types. 

Script or Manual Match 
Result 

A decision point in the diagram showing 
possible outcomes from the auto-match 
routing script or manual match. 

Workflows of all record types. 

Auto-match Routing Script Execute the Automatic Matching (Post) 
script for this record type.  The routing 
scripts are self-documented and can be 
viewed in the system by users with the 
appropriate permissions.  Go to System 
> Workflow > Task Manager; select the 
Routing tab.   

All record types excluding 
supplemental.  (Scripts will 
be supported for 
Supplemental records in 
v17.) 

Auto-build new Patient 
Set 

Build a new patient set from the record 
and apply the auto-build rules.  These 
rules define the value of each field in 
the record (copy value from patient set; 
set a default value based on year or 
other criteria; etc).  The registry’s rules 
are documented on the auto-build help 
page 
 

Abstract workflow, short 
health record workflow, case 
finding and pathology report 
workflow, and death 
certificate workflow 

Auto-consolidate into 
Patient Set 

Apply the auto-consolidation rules and 
update data in the Patient Set.  The 
rules are documented on the Auto-
consolidation help page. 

Workflows of all record types. 

Link AFL Source to Patient 
Set 

If the record closed an AFL, link that 
AFL’s source record.    
 
Example:  an abstract is linked to a 
CTC.  In a previous step of the 
workflow, the abstract had closed an 
AFL for a path report.   The Link AFL 
Source task links that path report to the 
same CTC as the abstract. 

Abstract workflow. 

Patient Set Edits Validate the patient set using edits with 
Data Type equal to Patient Set, NAACCR 
Line, and any data type that is a sub-
entity of the patient set (CTC, 
Treatment Procedure, etc). 
 
An edit is executed if it is active and the 
patient set meets criteria specified in 
the edit’s conditions. 

Workflows of all record types. 
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Process Description Workflows 
Evaluate AFLs & FB First, apply the AFL Auto-close Rules – 

Patient Set is Saved.  These rules are 
documented on the AFL help page.   
 
Second, apply any registry-specific rules 
to auto-create AFLs or Follow-back 
Needs.  These rules are documented on 
registry-specific workflow diagrams. 

Workflows of all record types. 

 

Technical Implementation of the Workflow 
The SEER*DMS workflow is highly configurable, the route of a record through the workflow is 
determined by registry rules based on record type, facility, and values of specific data items on the 
record.  The workflow diagrams show the workflow processes (tasks) and transition points.  The 
workflow implementation uses the system components listed below. 

• Workflow Engine.  The workflow engine is written in Java.  The workflow engine parses 
the workflow XML file, executes routing scripts, creates each task, and initiates the 
appropriate processes.   

• Workflow XML.  Task attributes and routing rules are defined in the registry’s 
workflow.xml file.  The contents of the XML file are described in more detail below. 

• Automatic Matching Routing Script.  The auto-match routing script is executed after the 
automated task for record linkage.  The script returns a routing code that defines the next 
workflow task for the record; the script’s logic is based on the match results and values of 
record data items.   

• Edits and Task-Specific Algorithms.  Each automated task uses task-specific logic to 
evaluate or modify data.  Edits and edit conditions are used by the automated edits tasks.   
Task-specific algorithms are in place for other automated tasks, including imports, 
screening, matching, auto-build, and auto-consolidation.   

Workflow XML 
The workflow XML defines the attributes of manual tasks, automated tasks, places, and transition 
points.  The attributes defined in the Workflow XML include those listed below.   This is not a 
complete list, these are included here to provide a basic understanding of the workflow 
implementation and to illustrate the way in which IMS may customize a registry’s workflow via 
changes to the Workflow XML. 

• activity id – This is a label or variable name used by the Workflow Engine and throughout 
the Workflow XML.  These are used behind the scenes and not displayed to the user 
(import-review, image-data-entry, etc.) 

• comment – A script that sets and formats variables displayed in the Information column of 
the worklist. 

• contained-entity-type – The type of object that is the focus of the task.  This object may 
be an import (SourceSubmission object), record, patient set, AFL, report, etc.  

• cleaner: java class (including full package) that must be executed when an activity of this 
type is terminated 

• name – The formatted title of a task.  These are the task names that are shown to the user 
(Import Review, Image Data Entry, etc.) 
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• no-restart – A Boolean that is set to True when a task cannot be sent to an earlier step in 
the workflow.  This is set to True for tasks that stand-alone and are not part of a full 
workflow; these include Review Data, QC Record, QC Patient Set, Review Special Studies, 
and Report Output. 

• no-retry – A Boolean that is set to True if the workflow does not permit a failed instance of 
the task to be re-tried.  For example, a failed automatic import task cannot be re-tried.  The 
cause of the failure would be investigated, corrected, and the files reloaded.  A new task 
would be created; and the failed task would be terminated. 

• ownership – Task ownership affects user assignment.  If ownership is set to previous-
owner then next manual task will be assigned to the same user as this task.  If the value is 
unassigned then the task will be set to unassigned after it is completed.  The task is then 
evaluated by workflow assignment scripts to see if the assignment should be changed. 

• permission – The system permission required by a person to open the task. 
• refresh-entry-point –  Some tasks can be refreshed, the automatic portion of the current 

task is re-executed.  The refresh-entry-point defines the point in the workflow that 
corresponds to the automatic portion of the task.   

• type – The type is “human” for all manual tasks; the type is java for automated tasks. 
 

Automatic Matching Routing Script 
Workflow routing scripts allow modifications to a registry’s workflow without requiring a release of 
the SEER*DMS application.  The proper maintenance of routing scripts requires an extensive 
understanding of the SEER*DMS workflow and the impact of changes to registry operations, 
therefore, the routing scripts should only be modified by IMS support staff in consultation with a 
registry operation manager.  Routing scripts can be viewed in the Task Manager (go to System > 
Workflow > Task Manager).  In SEER*DMS v16, the transition after automated matching is the 
only workflow transition controlled by a routing script.  Scripts for other transitions will be 
supported in versions 17 and 18 (to be released in 2015 and 2016).  
 
Each routing script is a Groovy script that returns a single string. The string is the name of a 
workflow disposition.  The valid dispositions for the transition after the automated match task are: 
 

• manual-matching:  The record will move to a Manual Match task. 
• auto-build:   The record will move to the auto-build task.  An attempt will be made to build 

a new patient set from the record. Registry workflow rules determine whether a patient set 
can be built or not. If a patient set cannot be built then a Manual Match task is created. If a 
patient set is built, other records that match the task’s focus record are sent back through 
the workflow so that they can be consolidated into the new patient set. 

• auto-consolidate: The record will be auto-consolidated to the perfect matched patient set. 
If an auto-consolidation rule fails, a manual Matching task will be created. 

• exit:  The record will exit the workflow.  The record will be stored in the database as an 
“unlinked” record. 

• create-afl-then-exit:  The record will create an AFL and then exit the workflow. 
 
A record is the entity processed in an automated match task.  The routing scripts can use record 
properties (data items) and a variety of utility methods.  The utility methods include functions that 
return information related to the preceding task.  For example, the script below uses methods to 
obtain results of the automated match results.  The task.numMatchedPerfectPatients syntax calls 
the getNumMatchedPerfectPatients method.  This method returns the number of patient sets that 
scored >= 1000 in the automated match task. 
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// if one perfect patient set found and diagnosis year < 2004,  
//      try to link the record to a CTC 
if (task.numMatchedPerfectPatients == 1 && entity.dateOfDiagnosisYear < '2004') 
    return 'auto-consolidate' 
 
// If this is a new patient, build a patient set 
//  In this example, the patient set is built if the abstract is reportable,  
//  does not match a patient set in the database, and does not match another abstract. 
if (task.numMatchedPatients == 0 && task.numMatchedAbstractRecords == 0  
                                                            && task.reportability == 1) 
    return 'auto-build' 
 
// if no patient set found and this record cannot build one, exit the workflow 
if (task.numMatchedPatients == 0 && !task.foundMasterRecord) 
    return 'exit' 
 
// If record did not meet criteria above then create a manual matching task 
return 'manual-matching' 

 
Edits and Task-Specific Algorithms 

Edits and edit conditions determine if a manual task is created to resolve record or patient set 
edits.  The Edits Manager provides a mechanism for writing edits, activating edits of various 
standard-setters, and setting conditions that determine the cases on which edits are applied.   

Task-specific algorithms are in place for other automated tasks, including imports, screening, 
matching, auto-build, and auto-consolidation.  The rules include criteria for creating manual tasks.  
These rules are documented in the SEER*DMS help system.  At this time, changes to these rules 
require a release of SEER*DMS.  Those rules will also be edited via a SEER*DMS editor in future 
versions of SEER*DMS (some of these changes may be included in 2015 and 2016 workflow 
modifications).   

Workflow Branches 
 
There are two distinct branches of the workflow:  the supplemental workflow and the main 
workflow.  The supplemental workflow is used for data that provide vital status, date of last 
contact, non-cancer cause of death information, and updates to other demographic data items.  
The main workflow is used for records that may provide cancer data.  

All current SEER*DMS registries use the supplemental workflow if the record’s subtype is 
supplemental (SSA, NDI, DMV, etc); or if the subtype is death certificate but there are no 
reportable causes of death on the death certificate.  A few registries also use the supplemental 
workflow for other record types such as death notice, follow-up transmit, and follow-up only.  The 
main workflow is used for records that may provide cancer data:  abstract records, pathology 
reports, case finding records, and death certificate records with reportable causes of death. 

The supplemental workflow is implemented via import routines that are external to the main 
workflow.  Typically, data processed in the supplemental workflow are not persisted in the record 
table unless a manual task is required to review automatic match results or resolve auto-
consolidation conflicts.   If SEER*DMS is able to match and consolidate the data without a manual 
task, the patient set is updated and the Import ID, filename, and line number are recorded in the 
patient set’s audit log.  The record is not saved.  However, SEER*DMS supports options that 
control the storage of data in the supplemental workflow.  For example, all SEER*DMS registries 
use the supplemental workflow for non-reportable death certificate records and most registries use 
the option to store all death certificate records in the database.
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